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Warranty and Disclaimer 
© Cypress Semiconductor Corporation, 2015-2016. This document is the property of Cypress Semiconductor Corporation and its subsidiaries, including 

Spansion LLC (“Cypress”).  This document, including any software or firmware included or referenced in this document (“Software”), is owned by Cypress 

under the intellectual property laws and treaties of the United States and other countries worldwide.  Cypress reserves all rights under such laws and treaties 

and does not, except as specifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights.  

If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of the 

Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to sublicense) (1) under its copyright rights in 

the Software (a) for Software provided in source code form, to modify and reproduce the Software solely for use with Cypress hardware products, only 

internally within your organization, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resellers 

and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress’s patents that are infringed by the Software (as 

provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware products.  Any other use, 

reproduction, modification, translation, or compilation of the Software is prohibited. 

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO 

THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make 

changes to this document without further notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described 

in this document.  Any information provided in this document, including any sample design information or programming code, is provided only for reference 

purposes.  It is the responsibility of the user of this document to properly design, program, and test the functionality and safety of any application made of this 

information and any resulting product.  Cypress products are not designed, intended, or authorized for use as critical components in systems designed or 

intended for the operation of weapons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or systems (including 

resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other uses where the failure of the device or 

system could cause personal injury, death, or property damage (“Unintended Uses”).  A critical component is any component of a device or system whose 

failure to perform can be reasonably expected to cause the failure of the device or system, or to affect its safety or effectiveness.  Cypress is not liable, in 

whole or in part, and you shall and hereby do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses of 

Cypress products.  You shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other liabilities, including claims for 

personal injury or death, arising from or related to any Unintended Uses of Cypress products. 

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-RAM, and Traveo are 

trademarks or registered trademarks of Cypress in the United States and other countries.  For a more complete list of Cypress trademarks, visit cypress.com. 

Other names and brands may be claimed as property of their respective owners. 
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Information about this PDF document 

 For your convenience this user guide includes external links that 

simplify installing of drivers, software utilities, and quick jumps to 

documentation. 

 Some PDF viewer do not allow access to external content by links 

because of security reasons. 

 A viewer called “PDF XChange” is provided in the software package 

of this starter kit. It’s use is free of charge and no additional 

installation is required. 

 Launching “start.bat” opens this user guide in the PDF XChange 

viewer. 

 Please ensure you have copied the complete software package 

related to this starter kit in order to use and run the links and 

examples given on the next pages. 

 Please contact the Cypress Support in case of any question. 
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Overview 

 MCU Features, Board Features & Contents 

 Please check jumper setting / Test it by a GUI 

 The Hardware / Pin Overview 

 The Jumper Table  / Jumper Default  

 Board Power 

 Software Examples & Tools  

 Flash Programming 

 JTAG / CMSIS-DAP 

 IAR-Embedded Workbench 

 KEIL µVision 

 Contacts & More 

 Additional documents 

 Schematic 

 Factsheet 

 Data sheet MB9B560R Series and Errata 

 Peripheral Manual and Errata 

 Peripheral Manual (Timer Part) and Errata 

 Peripheral Manual (Analog Part) 

 Peripheral Manual (Communication Part) and Errata 

 Flash Programming Manual and Errata 

 

Please visit www.cypress.com to find latest releases of 

the above mentioned documents. 

 

documentation
documentation/SK-FM4-U120-9B560-v1.2.0-20131126.pdf
documentation/MB9B560R-NP709-00001.pdf
documentation/MB9B560R-DS709-00001.pdf
documentation/MB9B560R-DS709-00001-1v0-E-DE.pdf
documentation/FM4_MN709-00001-2v0-E.pdf
documentation/FM4_MN709-00001-2v0-E-DE.pdf
documentation/FM4_MN709-00002-2v0-E.pdf
documentation/FM4_MN709-00002-2v0-E-DE.pdf
documentation/FM4_MN709-00003-2v0-E.pdf
documentation/FM4_MN709-00004-2v0-E.pdf
documentation/FM4_MN709-00004-2v0-E-DE.pdf
documentation/MB9B560R-MN709-00005-2v0-E.pdf
documentation/MB9B560R_MN709-00005-2v0-E-DE.pdf
http://www.cypress.com/
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Features of the microcontroller 

 The SK-FM4-U120-9B560 and SK-FM4-U120-9B560-MEM  
are based on the Cypress ARM® Cortex®-M4 device MB9BF568R 

 The MB9B560R Series includes the following features: 

• Up to 1 MByte Flash Memory and 32 KByte Work Flash Memory 

• Up to 128 KByte RAM 

• Up to 160MHz clock 

• Up to 2 CAN controller 2.0A/B 

• Up to 8 UART / LIN / SPI / I²C interfaces 

• USB-Host/-Device interface 

• SD-Card interface 

• Three 12 bit ADCs, up to 24 channels 

• Two 12 bit DACs 

• Up to 16 channel external interrupts 

• Two Multifunction timer with waveform generator, e.g. Motor control  

• Timers (ICUs, OCUs,  PPGs, others) 



SHOW TITLE MM/DD/YY 6 SLIDE OWNER 

Features of the board 

 The SK-FM4-U120-9B560(-MEM) is available in two versions: 

 Feature SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

External Power Supply USB, DAP, JTAG or from SK-FM4-U-PERIPHERAL 

On-board Voltage 3.3V or 5V 3.3V 

User-LEDs, Reset-LED 3x User-LEDs (R,G,B) + Reset 

Buttons 3x buttons: Reset + External Interrupt + NMI 

Potentiometer AN18 (0V .. On-board voltage 3.3V/5V) 

Debug interface On-board CMSIS-DAP incl. Status LEDs (connected, running) 
(optional 20 pin JTAG-IF to be used with external JTAG adapter) 

Virtual COM port (USB-2-UART bridge) Yes 

USB interface USB Function (Mini-USB Type B) 

SD-Card interface Yes No 

External Memory No NAND-Flash: 32MByte 

SDRAM: 16MByte 
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Contents SK-FM4-U120-9B560 

 The SK-FM4-U120-9B560(-MEM) contents 

• The SK-FM4-U120-9B560 or SK-FM4-U120-9B560-MEM evaluation 

board 

• One USB mini cable  

• 1-page flyer   

Box      SK-FM4-U120-9B560(-MEM)        USB cable  

                   

                        Additional information 

  

A B 
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Please check jumper setting 

 
SK-FM4-U120-9B560 supports 5V and 3.3V operation 

SK-FM4-U120-9B560-MEM supports only 3.3V operation 

Run 

LED 

3V 

NMI 

USBF 

USBF 

USB 

Note: 
Please set  J9 (USB) instead of J7 (CMSIS-DAP) 

Please set J19 and J20:1-2 (SIN0/SOT0) 

DAP 

S
IN

0
 

S
O

T
0
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Test it by terminal using USB 

 The microcontroller on the SK-FM4-U120-9B560(-MEM) 

is already preprogrammed with a test application (<drive:>\sw-examples\testsoftware) 

• Install the USB driver first <drive:>\drivers\driverinstaller.exe 

• Connect the starter kit to CN4 (USB) with your PC  

 Ensure jumper J9 (USB) is set for correct power supply 

 Ensure jumper J19 and J20:1-2 are set correctly for use of SIN0/SOT0 

• Press the ‚Reset‘- Button 

• Check the availability for virtual COM port 

 e.g. Windows Device Manager 

• Open a serial terminal tool 

 e.g. Cypress Serial Port Viewer  

<drive:>\tools\serialportviewer\setup.exe 

 Settings 115200 baud, 8N1 

• Press <space> to show welcome menu 

• Please select any function 

to test the on-board features 

drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
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Test it by a GUI 

 The microcontroller on the SK-FM4-U120-9B560(-MEM) 

is already preprogrammed with a test application (<drive:>\sw-examples\testsoftware) 

• Install the USB driver first <drive:>\drivers\driverinstaller.exe 

• Connect the starter kit to CN4 (USB) with your PC  

• Open the PC software  

<drive:>\sw-examples\testsoftware\SK-FM4-U120-9B560_demo.exe 

• The picture of the board will be shown 

with current status of on-board features 

• LED allows control of the RGB-LED 

 Just click to the checkboxes 

• Status of user-buttons SW2 and SW3 

are shown interactively  

• ADC represents the potentiometer R11 

 

 

 

 

drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
sw-examples/testsoftware/SK-FM4-U120-9B560_Demo.exe
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Test it 

 You finished successfully the first test 

 

 

 

 Next section covers: 

• The on-board features 

• How to program the Flash 

 Serial ROM Boot loader 

USB Direct 

UART0 

 On-board CMSIS-DAP 

 JTAG with optional emulator 

• How to start with IAR-Embedded-Workbench and KEIL µVision 
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Hardware 
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The Hardware (Top Side) – Jumper Overview 
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USB-
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The Hardware (Top Side) – Jumper Function Overview 
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The Hardware (Bottom Side) 
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(only SK-FM4-U120-9B560)  
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The Hardware – Pin Overview 1 - 20 

 
Pin Microcontroller-Function SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

1 VCC VCC_MCU 3V3 or 5V0 VCC_MCU 3V3 or 5V0 

2 P50/CTS4_0/AIN0_2/RTO10_0/INT00_0/MADATA00_0 SDRAM, NAND FLASH 

3 P51/RTS4_0/BIN0_2/RTO11_0/INT01_0/MADATA01_0 SDRAM, NAND FLASH 

4 P52/SCK4_0/ZIN0_2/RTO12_0/MADATA02_0 SDRAM, NAND FLASH 

5 P53/TIOA1_2/SOT4_0/RTO13_0/MADATA03_0 SDRAM, NAND FLASH 

6 P54/TIOB1_2/SIN4_0/RTO14_0/INT02_0/MADATA04_0 SDRAM, NAND FLASH 

7 P55/ADTG_1/SIN6_0/RTO15_0/INT07_2/MADATA05_0 SDRAM, NAND FLASH 

8 P56/SOT6_0/DTTI1X_0/INT08_2/MADATA06_0 SDRAM, NAND FLASH 

9 P57/SCK6_0/MADATA07_0 SDRAM, NAND FLASH 

10 P58/SIN4_2/AIN1_0/INT04_2/MADATA08_0 SDRAM 

11 P59/RX1_1/SOT4_2/BIN1_0/INT07_1/MADATA09_0 SDRAM 

12 P5A/TX1_1/SCK4_2/ZIN1_0/MADATA10_0 SDRAM 

13 P5B/CTS4_2/MADATA11_0 SDRAM 

14 P30/TIOB0_1/RTS4_2/INT15_2/WKUP1/MADATA12_0 SDRAM 

15 P31/TIOB1_1/SIN3_1/INT09_2/MADATA13_0 SDRAM 

16 P32/TIOB2_1/SOT3_1/INT10_1/MADATA14_0 SDRAM 

17 P33/ADTG_6/TIOB3_1/SCK3_1/INT04_0/MADATA15_0 SDRAM 

18 P34/TX0_1/TIOB4_1/FRCK0_0/MNALE_0 NAND FLASH 

19 P35/RX0_1/TIOB5_1/IC03_0/INT08_1/MNCLE_0 NAND FLASH 

20 P36/SIN5_2/IC02_0/INT09_1/MNWEX_0 NAND FLASH 
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The Hardware – Pin Overview 21 - 40 

 
Pin Microcontroller-Function SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

21 P37/SOT5_2/IC01_0/INT05_2/MNREX_0 NAND FLASH 

22 P38/SCK5_2/IC00_0/INT06_2 LED_G LED_G 

23 P39/ADTG_2/DTTI0X_0/RTCCO_2/SUBOUT_2/MSDCLK_0 SDRAM 

24 P3A/TIOA0_1/AIN0_0/RTO00_0/MSDCKE_0 SDRAM 

25 P3B/TIOA1_1/BIN0_0/RTO01_0/MRASX_0 SDRAM 

26 P3C/TIOA2_1/ZIN0_0/RTO02_0/MCASX_0 SDRAM 

27 P3D/TIOA3_1/RTO03_0/MAD00_0 SDRAM 

28 P3E/TIOA4_1/RTO04_0/MAD01_0 SDRAM 

29 P3F/TIOA5_1/RTO05_0/MAD02_0 SDRAM 

30 VSS GND GND 

31 VCC VCC_MCU 3V3 or 5V0 VCC_MCU 3V3 or 5V0 

32 P40/TIOA0_0/RTO10_1/INT12_1 

33 P41/TIOA1_0/RTO11_1/INT13_1 

34 P42/TIOA2_0/RTO12_1/MSDWEX_0 SDRAM 

35 P43/ADTG_7/TIOA3_0/RTO13_1/MCSX8_0 SDRAM 

36 P44/TIOA4_0/RTO14_1/DA0 

37 P45/TIOB0_0/RTO15_1/DA1 

38 INITX Button Reset / JTAG Button Reset / JTAG 

39 P46/X0A Sub-Crystal 32.768 kHz Sub-Crystal 32.768 kHz 

40 P47/X1A Sub-Crystal 32.768 kHz Sub-Crystal 32.768 kHz 
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The Hardware – Pin Overview 41 - 60 

 
Pin Microcontroller-Function SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

41 P48/VREGCTL 

42 P49/VWAKEUP Pull-Down resistor Pull-Down resistor 

43 VBAT Battery (CN1) Battery (CN1) 

44 C Capacitor 4u7 Capacitor 4u7 

45 VSS GND GND 

46 VCC VCC_MCU 3V3 or 5V0 VCC_MCU 3V3 or 5V0 

47 P4B/TIOB1_0/SCS7_1/MAD03_0 SDRAM 

48 P4C/TIOB2_0/SCK7_1/AIN1_2/MAD04_0 SDRAM 

49 P4D/TIOB3_0/SOT7_1/BIN1_2/INT13_2/MAD05_0 SDRAM 

50 P4E/TIOB4_0/SIN7_1/ZIN1_2/FRCK1_1/INT11_1/WKUP2/MAD06_0 SDRAM 

51 P70/TX0_0/TIOA4_2/AIN0_1/IC13_1 

52 P71/RX0_0/TIOB4_2/BIN0_1/IC12_1/INT15_1 

53 P72/TIOA6_0/SIN2_0/ZIN0_1/IC11_1/INT14_2 

54 P73/TIOB6_0/SOT2_0/IC10_1/INT03_2 USB USB 

55 P74/SCK2_0/DTTI1X_1 

56 PE0/MD1 LED_B / MD1 LED_B / MD1 

57 MD0 MD0 MD0 

58 PE2/X0 Main-Crystal 4 MHz Main-Crystal 4 MHz 

59 PE3/X1 Main-Crystal 4 MHz Main-Crystal 4 MHz 

60 VSS GND GND 
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The Hardware – Pin Overview 61 - 80 

 
Pin Microcontroller-Function SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

61 VCC VCC_MCU 3V3 or 5V0 VCC_MCU 3V3 or 5V0 

62 P10/AN00/RX1_2/SIN1_1/FRCK0_2/INT02_1/MAD07_0 SDRAM 

63 P11/AN01/TX1_2/SOT1_1/IC00_2/MAD08_0 SDRAM 

64 P12/AN02/SCK1_1/IC01_2/RTCCO_1/SUBOUT_1/MAD09_0 SDRAM 

65 P13/AN03/SIN0_1/IC02_2/INT03_1/MAD10_0 SDRAM 

66 P14/AN04/SOT0_1/IC03_2/MAD11_0 SDRAM 

67 P15/AN05/SCK0_1/MAD12_0 

68 P16/AN06/SIN2_2/INT14_1/MAD13_0 

69 P17/AN07/SOT2_2/WKUP3/MAD14_0 SDRAM 

70 AVCC VCC_MCU VCC_MCU 

71 AVSS GND GND 

72 AVRL GND GND 

73 AVRH VCC_MCU VCC_MCU 

74 P18/AN08/SCK2_2/MAD15_0 SDRAM 

75 P19/AN09/SIN4_1/IC00_1/INT05_1/MAD16_0 

76 P1A/AN10/SOT4_1/IC01_1/MAD17_0 

77 P1B/AN11/SCK4_1/IC02_1/MAD18_0 

78 P1C/AN12/CTS4_1/IC03_1/MAD19_0 

79 P1D/AN13/RTS4_1/DTTI0X_1/MAD20_0 

80 P1E/AN14/ADTG_5/FRCK0_1/MAD21_0 
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The Hardware – Pin Overview 81 - 100 

 
Pin Microcontroller-Function SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

81 P1F/ADTG_4/TIOB6_2/RTO05_1 

82 P27/TIOA6_2/RTO04_1/INT02_2 LED_R LED_R 

83 P26/TIOB5_0/SCK2_1/RTO03_1 

84 P25/TX1_0/TIOA5_0/SOT2_1/RTO02_1 

85 P24/RX1_0/SIN2_1/RTO01_1/INT01_2 

86 P23/AN15/TIOA7_1/SCK0_0/RTO00_1/MAD22_0 

87 P22/CROUT_0/AN16/TIOB7_1/SOT0_0/ZIN1_1 JTAG JTAG 

88 P21/AN17/SIN0_0/BIN1_1/INT06_1/MAD23_0 JTAG JTAG 

89 P20/AN18/AIN1_1/INT05_0/MAD24_0 Potentiometer R11 Potentiometer R11 

90 VSS GND GND 

91 VCC VCC_MCU 3V3 or 5V0 VCC_MCU 3V3 or 5V0 

92 P0E/TIOB5_2/SCS6_1/IC13_0/S_CLK_0/MDQM1_0 SD-Card SDRAM 

93 P0D/TIOA5_2/SCK6_1/IC12_0/S_CMD_0/MDQM0_0 SD-Card SDRAM 

94 P0C/TIOA6_1/SOT6_1/IC11_0/S_DATA1_0/MALE_0 SD-Card 

95 P0B/TIOB6_1/SIN6_1/IC10_0/INT00_1/S_DATA0_0/MCSX0_0 SD-Card NAND FLASH 

96 P0A/SIN1_0/FRCK1_0/INT12_2/S_DATA3_0/MCSX1_0 SD-Card 

97 P09/AN19/TRACED0/TIOA3_2/SOT1_0/S_DATA2_0/MCSX5_0 SD-Card 

98 P08/AN20/TRACED1/TIOB3_2/SCK1_0/MCSX4_0 

99 P07/AN21/TRACED2/TIOA0_2/SCK7_0/MCLKOUT_0 

100 P06/AN22/TRACED3/TIOB0_2/SOT7_0/MCSX3_0 
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The Hardware – Pin Overview 101 - 120 

 Pin Microcontroller-Function SK-FM4-U120-9B560 SK-FM4-U120-9B560-MEM 

101 P05/AN23/ADTG_0/TRACECLK/SIN7_0/INT01_1/MCSX2_0 

102 P04/TDO/SWO JTAG JTAG 

103 P03/TMS/SWDIO JTAG JTAG 

104 P02/TDI/MCSX6_0 JTAG JTAG 

105 P01/TCK/SWCLK JTAG JTAG 

106 P00/TRSTX/MCSX7_0 JTAG JTAG 

107 VSS GND GND 

108 P68/TIOB7_2/SCK3_0/INT00_2 Button INT Button INT 

109 P67/TIOA7_2/SOT3_0 

110 P66/ADTG_8/SIN3_0/INT11_2 

111 P65/TIOB7_0/SCK5_1 

112 P64/TIOA7_0/SOT5_1/INT10_2 

113 P63/CROUT_1/RX0_2/SIN5_1/INT03_0/S_CD_0/MWEX_0 SD-Card 

114 P62/ADTG_3/TX0_2/SIN5_0/INT04_1/S_WP_0/MOEX_0 SD-Card 

115 P61/UHCONX0/TIOB2_2/SOT5_0/RTCCO_0/SUBOUT_0 USB USB 

116 P60/TIOA2_2/SCK5_0/NMIX/WKUP0/MRDY_0 Button NMIX Button NMIX 

117 USBVCC 3V3 3V3 

118 P80/UDM0 USB USB 

119 P81/UDP0 USB USB 

120 VSS GND GND 
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Jumper table 

 
Jumper Function SK-FM4-U120-9B560(-MEM) 

(Default setting marked bold) 

J1 (2 pin) 
CMSIS-DAP Crystal (P22) 

(Do not change!) 

Open: 4MHz 

Closed: 48MHz 

J2 (2 pin) VBUS detection of CMSIS-DAP 
Open: 3V3 

Closed: 5V (only for SK-FM4-U120-9B560) 

J3 (2 pin) CMSIS-DAP reset 
Open:  CMSIS-DAP normal operation 

Closed:  CMSIS-DAP reset assert 

J4 (2 pin) Operation of MD1 (CMSIS-DAP) 
Open: Run-Mode 

Closed: Test-Mode 

J5 (2 pin) Operation of MD0 (CMSIS-DAP) 
Open: Run-Mode (CMSIS-DAP) 

Closed: Firmware update of CMSIS-DAP 

J6-J9  
Power Supply Source 

Please select just one power source! 

J9: USB Host powered (CN4) 

J8: JTAG powered (CN2) 

J7: CMSIS-DAP powered (CN3) 

J6: Powered by SK-FM4-U-PERIPHERAL (J16) 

J10 (2 pin) 
SW3 NMI 

Jumper J10 needs to be opend for programming 

Open: Button SW3 disconnected / Programming mode 

Closed: Button SW3 (NMI) is connected 

J11 (2 pin) USB D+ 
Open: USB is disconnected 

Closed: USB is connected 

J12 (2 pin) USB D- 
Open: USB is disconnected 

Closed: USB is connected 

J13 (2 pin) VBUS detection 
 Open: 3V3 

Closed: 5V (only for SK-FM4-U120-9B560) 
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Jumper table (continued) 

 
Jumper Function SK-FM4-U120-9B560(-MEM) 

(Default setting marked bold) 

J14 (3 pin) 
USB VBUS detection 

 See also J10 

1-2: VBUS is connected to INT03_2 (Run-Mode) 

2-3: VBUS is connected to NMIX (Programming Mode) 

J15 (3 pin) 
MCU voltage selection 

SK-FM4-U120-9B560-MEM can be used with 3V3 only 

1-2: MCU is powered from 3V3 

2-3: MCU is powered from 5V (not SK-FM4-U120-9B560-MEM) 

J17 (2 pin) 
Operation of MD1 

(Do not change!) 

Open: Run-Mode and Programming-Mode 

Closed: Test-Mode 

J18 (2 pin) Operation of MD0 
Open: Run-Mode 

Closed: Programming-Mode 

J19 (2 pin) CMSIS-DAP Virtual COM port (SIN0_0) 
Open: SIN0 is disconnected from CMSIS-DAP 

Closed: CMSIS-DAP’s virtual COM port is connected 

J20 (3 pin) CMSIS-DAP Virtual COM port (SOT0_0) 
2-3: SOT0/P22 is used for USB programming 

1-2: CMSIS-DAP’s virtual COM port is connected 

J21 (3 pin) 
MD1/PE0 

See also J17 

1-2: MD1 (Programming-Mode) 

2-3: PE0 (LED Blue) 

J22 (2 pin) 
X0/PE2 

Do not close J22 if crystal Y1 is assembled. 

Open: PE2 is disconnected 

Closed: PE2 is connected to pin header U2 

J23 (2 pin) 
X1/PE3 

Do not close J23 if crystal Y1 is assembled. 

Open: PE3 is disconnected 

Closed: PE3 is connected to pin header U2 

J24 (2 pin) 
X0A/P46 

Do not close J24 if crystal Y2 is assembled. 

Open: P46 is disconnected 

Closed: PE2 is connected to pin header U2 

J25 (2 pin) 
X1A/P47 

Do not close J25 if crystal Y2 is assembled. 

Open: P47 is disconnected 

Closed: PE2 is connected to pin header U2 
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Jumper – Default (Run mode, CMSIS-DAP) 

 
SK-FM4-U120-9B560 supports 5V and 3.3V operation 

SK-FM4-U120-9B560-MEM supports only 3.3V operation 

Run 

LED 

3V 

NMI 

USBF 

USBF 

S
IN

0
 

S
O

T
0

 

DAP 
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Jumper – Programming Mode (USB Direct mode) 

 

Prog 

MD1 

3V/5V 

(U5V) 

USB 

NMI 

USBF 

USBF 

(U5V) 

M
D

0
 

S
IN

0
 

P
2

2
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Jumper – Power the Starter kit 

 The starter kit can be powered 

• by peripheral base-board (J16):   Close jumper J6 

• by  CMSIS-DAP (CN3):           Close jumper J7 (default) 

• by external JTAG (CN2):          Close jumper J8 

• by USB-host (CN4):          Close jumper J9 

 

 

 3.3V or 5V 

• Jumper J15 selects the target voltage 

 SK-FM4-U120-9B560 can operate 3.3V or 5V 

 SK-FM4-U120-9B560-MEM can operate 3.3V only 

• Default: J15: 1-2 (3.3V) 
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Software 
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Software Examples (1/2) -  Simple Software 

 Simple example that demonstrates the usage of some peripherals 

• Available for IAR EWARM or KEIL µVision: 

See <drive:>\sw-examples\ or www.cypress.com  

• mb9bf56xr_template 

 ‚Empty‘ project as base for user applications 

• mb9bf56xr_adc_dvm 

 Digital Voltage Meter based on the A/D-Converter and UART 

• mb9bf56xr_gpio 

 I/O example to control LEDs and readout the user buttons 

• mb9bf56xr_mfs 

 An UART example allows serial communication 

 
   

sw-examples
sw-examples
sw-examples
sw-examples
sw-examples
http://www.cypress.com/
sw-examples/mb9bf56xr_template-v12
sw-examples/mb9bf56xr_adc_dvm-v11
sw-examples/mb9bf56xr_gpio-v11
sw-examples/mb9bf56xr_mfs-v11
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Software Examples (2/2) – Peripheral Driver Library (PDL) 

 Example projects that are built with PDL (Peripheral Driver 

Library) 

• Available for IAR EWARM or KEIL µVision: 

See <drive:>\sw-examples\ or www.cypress.com  

• mb9bf56xr_pdl 

 The Peripheral Drivel Library (PDL) includes an API for all peripherals 

mb9bf56xr_pdl_adc_dvm : Example for ADC 

mb9bf56xr_pdl_gpio : Example for simple IO access 

mb9bf56xr_pdl_mfs : Example for serial communication (UART) 

mb9bf56xr_pdl_template : Project frame for user applications based on PDL 

 Functional test 

• tp_sk-fm4-u120-9b560 

 Program for Please check the jumper setting the board features (LEDs, 

buttons, ADC, USB, ...) 
 

 

 

sw-examples
sw-examples
sw-examples
sw-examples
sw-examples
http://www.cypress.com/
sw-examples/mb9bf56xr_pdl-v11
sw-examples/testsoftware
sw-examples/testsoftware
sw-examples/testsoftware
sw-examples/testsoftware
sw-examples/testsoftware
sw-examples/testsoftware
sw-examples/testsoftware
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Software Tools 

 The following software utility tools are available 

• USB Virtual-COM port  

 allows UART communciation via the PC‘s USB connection 

 On-board UART-2-USB converter (via CN3, CMSIS-DAP) 

 For driver installation <drive:>\drivers\driverinstaller.exe 

• FLASH USB DIRECT Programmer  

 Microcontroller Flash programming (via CN4, USB-Device-Port) 

 Install from  <drive:>\tools\USBDIRECT\setup.exe 

• Terminal program ‚Serial Port Viewer‘ 

 Install from  <drive:>\tools\serialportviewer\setup.exe 

drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
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Flash Programming 
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Flash Programming 

 There are several options to program the microcontroller’s flash: 

• FLASH USB DIRECT Programmer via CN4 (USB) 

 For installation <drive:>\tools\USBDIRECT\setup.exe  

 USB driver is located in subdirectory of FLASH USB DIRECT Programmer  

• FLASH MCU Programmer via CN3 (Serial by use of virtual COM-port) 

 For installation <drive:>\tools\PCWFM\setup.exe  

 For driver installation of USB/Virtual-COM port 

<drive:>\drivers\driverinstaller.exe 

• JTAG Programming via CN3 (CMSIS-DAP) 

 Example is given for IAR and KEIL 

 See documentation of your development suite, how to setup CMSIS-DAP 

• JTAG Programming via CN2 (optional JTAG adapter) 

 The correct JTAG-adapter must be selected in the IDE toolchain  

 No dedicated jumper setting is required 

tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM3/setup.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
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Flash Programming via CN4 (USB direct) 

 FLASH USB DIRECT Programming via CN4 (USB) 

• Jumper Setting 

 Close J9 (Power:USB), J11 (USB D+), J12 (USB D-) and J18 (MD0) 

 Set J14 to position 2-3  (P60, USB_VCC_DETECT) 

 Set J20 to position 2-3 (P22) 

 Set J21 to position 1-2 (MD1) 

 For 5V operation set J15 to 2-3, close J2 and J13 

 For 3.3V operation set J15 to 1-2, open J2 and J13 

• Connect the board via USB-Device (CN4) to the USB-Port of the PC 

 If connected for first time Windows OS may ask for a driver 

See subfolder ‚driver‘ of USBdirect installation path 

or <drive:>\tools\USBDIRECT\driver 

• Start the FLASH USB DIRECT Programmer 

 For first installation: <drive:>\tools\USBDIRECT\setup.exe  

 

 

/tools/USBDIRECT/driver
tools/USBDIRECT/driver
tools/USBDIRECT/driver
tools/USBDIRECT/driver
tools/USBDIRECT/driver
tools/USBDIRECT/driver
/tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe
tools/USBDIRECT/setup.exe


SHOW TITLE MM/DD/YY 34 SLIDE OWNER 

Flash Programming via CN4 (USB direct) 

Jumper setting PRG-mode using USB direct 

Prog 

MD1 

3V/5V 

(U5V) 

USB 

NMI 

USBF 

USBF 

(U5V) 

M
D

0
 

S
IN

0
 

P
2

2
 

Connect 

PC 



SHOW TITLE MM/DD/YY 35 SLIDE OWNER 

Flash Programming via CN4 (USB direct) 

 Choose the right target MCU MB9BF568M/N/R 

 Browse for the programming file (*.srec or *.hex) 

• IAR: see subfolder <project>\example\IAR\output\release\exe 

• ARM/KEIL: see subfolder <project>\example\ARM\output\release 

 Adjust the corresponding virtual COM-port 

 

 

 Use Full Operation 

• Download 

• Erase / Blank check 

• Program & Verify 

 Reset jumpers and return to Run-mode jumper setting 

Select MCU: MB9BF568M/N/R  

Select file (*.srec; *.hex) 

Select Virtual COM-port 
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Flash Programming via CN4 (USB direct) 

Jumper setting RUN-mode using USB direct 

3V/5V 

(U5V) 

USB 

NMI 

USBF 

USBF 

(U5V) 

S
IN

0
 

S
O

T
0

 

Run 

LED 

Connect 

PC 
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Flash Programming via CN3 (Serial) 

 FLASH MCU Programming via CN3 (Serial)* 

• Jumper setting 

 Open jumpers J3 (JTAG) and J10 (NMIX) 

 Close jumpers J7 (Power: DAP), J18 (MD0) and J19 (SIN0) 

Do not set J9 (USB Host powered)! 

 Set J20 to position 1-2 (SOT0) 

 Set J21 to position 1-2 (MD1) 

 Check jumper setting: J14:2-3  (P60) 

• Connect the board via USB CMSIS-DAP (CN3) to the USB-Port of the 

PC 

 When connected for first time Windows OS may ask for 

‚spansionusbvcomm.inf‘ 

<drive:>\drivers\cmsis-dap 

• Use the FLASH MCU Programmer for FM3/FM4 

 For installation <drive:>\tools\PCWFM\setup.exe 

 *Note: Do not connect CN4 to PC/USB while using serial programming 

/drivers/cmsis-dap
drivers/cmsis-dap
drivers/cmsis-dap
drivers/cmsis-dap
drivers/cmsis-dap
drivers/cmsis-dap
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
tools/PCWFM/setup.exe
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Flash Programming via CN3 (Serial) 

Jumper setting PRG-mode using CMSIS-DAP (serial communication) 

Prog 

MD1 

3V/5V 

(U5V) 

NMI 

USBF 

USBF 

(U5V) 

M
D

0
 

S
IN

0
 

S
O

T
0

 

DAP 

Connect 

PC 
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Flash Programming via CN3 (Serial) 

 Choose the right target MCU MB9BF568M/N/R 

 Select 4MHz Crystal Frequency 

 Browse for the programming file (*.srec or *.hex) 

• IAR: see subfolder <project>\example\IAR\output\release\exe 

• ARM/KEIL: see subfolder <project>\example\ARM\output\release 

 Adjust the corresponding virtual COM-port 

 

 

 

 

 

 

 Reset jumpers and return to Run-mode jumper setting 

Select MCU: MB9BF568M/N/R  

Select 4MHz Crystal Frequency 

Select file (*.srec / *.hex) 

Select Virtual COM-port 

Execute ‚Full Operation‘ 

  incl. stand-alone operations 

    - Download 

    - Erase 

    - Blank Check 

    - Program&Verify 
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Flash Programming via CN3 (Serial) 

Jumper setting RUN-mode using CMSIS-DAP (serial communication) 

3V/5V 

(U5V) 

NMI 

USBF 

USBF 

(U5V) 

S
IN

0
 

S
O

T
0

 

DAP 

Run 

LED 

Connect 

PC 



SHOW TITLE MM/DD/YY 41 SLIDE OWNER 

JTAG Debugger 
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JTAG adapter CMSIS-DAP 

 This starter kit includes an on-board JTAG adapter 

• Compatible to CMSIS-DAP 
http://www.keil.com/support/man/docs/dapdebug/dapdebug_introduction.htm  

• Please update the on-board CMSIS-DAP with latest firmware 

• Select debugger CMSIS-DAP in your tool chain 

 Any other JTAG-adapter can be connected to CN2, too. 

• Select used JTAG-adapter within IDE tool chain (No jumper setting is required) 

 Additional virtual COM port is provided by CN3 

 For driver installation <drive:>\drivers\driverinstaller.exe  

 Please set jumper J19 and J20 accordingly 

 

CMSIS-DAP MB9BF568R CN3 (USB) 
JTAG 

SIN0/SOT0 

CN2 (JTAG) 

http://www.keil.com/support/man/docs/dapdebug/dapdebug_introduction.htm
tools/cmsisdap_fw_update
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
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CMSIS-DAP Firmware update 

Please see instructions coming with Firmware update package! 
See <drive:>tools\cmsisdap_fw_update 

CMSIS-

DAP 

Virt. COM 

Prog/Run 

3V/5V 

LED 

S
IN

0
 

S
O

T
0

 

Prog/Run 

(U5V) 

MD0 

DAP 

NMI 

USBF 

USBF 

(U5V) 

tools/cmsisdap_fw_update
tools/cmsisdap_fw_update
tools/cmsisdap_fw_update
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Test it by terminal using CMSIS-DAP 

 The microcontroller on the SK-FM4-U120-9B560(-MEM) 

is already preprogrammed with a test application (<drive:>\sw-examples\testsoftware) 

• Install the USB Driver first <drive:>\drivers\driverinstaller.exe 

• Connect the starter kit to CN3 (CMSIS-DAP) with your PC  

 Ensure jumper J7 (CMSIS-DAP) is set for correct power supply 

• Press the ‚Reset‘- Button 

• Check the availability for virtual COM port 

 e.g. Windows Device Manager 

• Open a serial terminal tool 

 e.g. Cypress Serial Port Viewer  

<drive:>\tools\serialportviewer\setup.exe 

 Settings 115200 baud, 8N1 

• Press <space> to show welcome menu 

• Please select any function 

to test the on-board features 

drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
drivers/driverinstaller.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
tools/serialportviewer/setup.exe
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JTAG adapter CMSIS-DAP – using IAR 

Setup in IAR EWARM (1) 

Navigate to project options: 

Via Files-List 

Right-click at the project 

Select [Options...] 

 

Or via menu tab [Project] 

Select [Options...] 
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JTAG adapter CMSIS-DAP – using IAR 

Setup in IAR EWARM (2) 

Setup Project Debbuger Options 

(1) Navigate to [Debugger] 

(2) Select tab [Setup] 

(3) Select driver [CMSIS-DAP] 

 

 

(4) Select in [CMSIS-DAP] 

(5) Select tab [JTAG/SWD] 

(6) Select [SWD] 

 

 

1 

2 

3 

4 

5 

6 
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JTAG adapter CMSIS-DAP – using Keil 

Setup in Keil µVision (1) 

Navigate to project options: 

Via Project 

Right-click at the project 

Select [Options...] 

 

Or via menu tab [Project] 

Select [Options...] 
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JTAG adapter CMSIS-DAP – using Keil 

Setup in Keil µVision (2) 

Setup Debug & Utilities 

(1) Select tab [Debug] 

(2) Select [CMSIS-DAP Debugger] 

 

 

 

(3) Select tab [Utilities] 

(4) Select [CMSIS-DAP Debugger] 

1 

2 

3 

4 
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IAR Embedded Workbench 

 

Installation 

Getting Started 

Open Project 

Build Project 

Debug Project 
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IAR Workbench Getting Started 

 Install EWARM from IAR-CD or download latest version from IAR 

Website 

• EWARM size-limited (32k) or time-limited (full) Evaluation Version 

 http://supp.iar.com/Download/SW/?item=EWARM-EVAL 

 Start EWARM Workbench 

 Choose File → Open → Workspace 
• e.g.: <drive:>\sw-examples\mb9bf56xr_gpio-v11\example\IAR\mb9bf56xr_io.eww   

 

http://supp.iar.com/Download/SW/?item=EWARM-EVAL
http://supp.iar.com/Download/SW/?item=EWARM-EVAL
http://supp.iar.com/Download/SW/?item=EWARM-EVAL
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
sw-examples/mb9bf56xr_gpio-v11/example/IAR/mb9bf56xr_gpio.eww
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IAR Workbench – Main Window 

 IAR Workbench 

• Workspace on left side 

of Workbench window 

 If hidden then View→Workspace 

• Source files on right 

side of Workbench 

window as tabbed 

windows 

• Project open 

File → Open → Workspace → *.eww  

• For new projects 

start with ‚mb9bf56xr_template’ 
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IAR Workbench – Menu Bar 

 IAR Menu Bar 

 File Control 
(new, open, 

save, etc.) 

Edit Control 
(cut, copy, 

paste, undo, 

redo) 

Configuration 

Control 
(e.g. RAM or ROM 

debugging) 

Navigation Control 
(Find, Bookmarks, File 

Navigation, etc.) 

Build Control 
(compile, make, 

stop build) 

Debug Control 
(Breakpoint, start 

Debug w/ and w/o 

download) 
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IAR Workbench – Workspace 

 IAR Workspace Window 

 

Project Name 

Sub Folder Modules 

Main Modules 

Module Includes 

Project Description 

Project Built Output 
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IAR Workbench – Making Project 

 Making the Project 

• Use Make-Icon (      ), <F7> or 

Menu: Project→Make 

• Check for no errors in Output window 

below 

• Build errors are indicated by       or 

In Output window and Source view 
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IAR Workbench – Download to Target 

 Download to Target and Start Debugging 

• Use       Icon, <Ctrl>-D, or Project→Download and Debug 

• A new menu bar will occur on sucessful connection to target 

 

Reset 

Target 

Stop 

Step 

Over 

Step 

Into 

Step 

Out 

Next 

Statement 

Run to 

Cursor 

Run 

End 

Debugging 

Trace 

Control 
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IAR Workbench – Debug (1) 

 Source Window 

• The Source windows do not change contents but get additional 

information 

 Current line (PC): 

 Halted on Breakpoint: 

 Halted on Data break (example):   

 Disassembly Window 

• Shows ‘pure‘ disassebly view 

• Shows mixed mode view 
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IAR Workbench – Debug (2) 

 Watch Window 

• Watch 

 Expressions/Variables have to be added by user and are updated by 

Halt/Breakpoint 

 

 

 

• Quick Watch 

 The Quick watch allows the user to calculate and recalculate expressions 

even with variables 

 

 

 

 The drop down menu memorizes the last typed contents 
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IAR Workbench – Simulator 

 Simulator 

• Mark Project File in Workspace 

• Choose Project→Options 

• Choose Simulator in Debugger Setup 

• Start Simulator with usual      Icon 
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KEIL µVision 

 

Installation 

Getting Started 

Open Project 

Build Project 

Debug Project 
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KEIL µVision IDE and Debugger Getting Started 

 Install µVision from KEIL-CD or download latest version from KEIL 

Website 

• Evaluation Version 

 https://www.keil.com/demo/eval/arm.htm 

 Registration required 

 Install ULINK-ME  

• Special installation is not needed, because ULINK-ME acts as a USB 

Human Interface Device (HID) and thus needs no extra USB driver 

 Install ULINK Pro (optional) 

• ULINK Pro needs an own dedicated USB driver located in: 

<Installation Path>\KEIL\ARM\ULINK 

 Start µVision 

 

https://www.keil.com/demo/eval/arm.htm
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KEIL µVision – Getting Started 

 Choose Menu: Project→Open Project... 

• Browse to: <drive:>\sw-examples\mb9bf56xr_gpio-v11\example\ARM\ 

• Choose mb9bf56xr_gpio.uvproj 

sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
sw-examples/mb9bf56xr_gpio-v11/example/ARM/
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KEIL µVision – Main Window 

 KEIL µVision 

• Project window on left side of 

IDE window 

 Choose: 

View→Project Window 

if hidden 

• Source files on right side 

of IDE window as tabbed 

windows 

• Output window on bottom 

side of IDE window  
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KEIL µVision – Menu Bars (1) 

 Menu Bar 1 

• Can be moved in bar window area or set floating 

 

File Control 
(new, open, 

save, etc.) 

Edit Control 
(cut, copy, paste, etc.) 

(indention, commenting) 

Navigation Control 
(Bookmarks + search, etc.) 

(Text search, search in files, etc.) 

Debug Control 
(Start/Stop Debug Session, 

set/remove/disable 

breakpoints, remove/disable 

all breakpoints) 

Project 

Window View 

IDE 

Configuration 
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KEIL µVision – Menu Bars (2) 

 Menu Bar 2 

• Can be moved in bar window area or set floating 

 
Build Control 

(Compile [Translate], 

Build, Rebuild, etc.) 

Download 

to Target 

Configuration 

Control 
(e.g. RAM or ROM 

debugging) 

Target 

Options 

Manage Books, 

File Extensions, 

Environment 

Manage 

Multi-

Project 

Workspace 

MB9BF51x Release 
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KEIL µVision – Project Window 

 µVision Project Window 

 
Project Name 

Startup Code Subfolder 

Startup Code Source and Header Files 

Main Project Code Subfolder 

Main Project Code Source and Header 

Files 

Project Description Subfolder and 

Abstract File 
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KEIL µVision – Making Project 

 Making the Project 

• Use Rebuild Icon 

(      ) or 

Project→Rebuild all target 

files 

• Check for no errors in 

Output window below 

 

• Build errors are shown in Output window. 

 Can be double-clicked by showing the source line with a blue arrow 
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KEIL µVision – Debug (1) 

 Start Debugging 

• Download to target first, when MCU Flash does not contain the current 

application openend and built in the IDE 

 Use Download Icon (      ) or Menu: Flash→Download 

• Start Debug Session 

 Use Start/Stop Debug Icon (       ) or Menu: Debug→Start/Stop Debug 

Session 

• Ending Debug Session 

 Use same way as for starting debug session 
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KEIL µVision – Debug (2) 

 Debugging Icon Bar 

• During a Debug Session there will be visible a new icon bar 

 
Reset 

Target 

Start/ 

Stop 

Application 

Step Control 
(Step in, out, etc.) 

Show 

Source/Code 

Line of current 

PC 

Show Windows (Command, 

Disassembly, Symbols, 

Registers, Call Stack) 

Show (multiple) 

Windows 
(Watch, Memory, Serial, 

Analysis, Trace, System 

Viewer) 

Tool Box 
(can be 

customized) 

Debug 

Restore 

Views 
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KEIL µVision – Debug (3) 

 Source View 

• The Source windows do not change contents but get additional 

information 

 Active Breakpoint 

Disabled Breakpoint 

Current Program 

Counter 

Current Cursor Line of 

Source Code 

Code Lines with 

compiled Instructions 

(dark grey    ) 
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KEIL µVision – Debug (4) 

 Disassembly View 

• Mixed mode is selectable and deselectable 

 
Active Breakpoint 

Disabled Breakpoint 

Current Program 

Counter 

Current Cursor Line of 

Code highlighted in 

yellow background (   ) 
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KEIL µVision – Debug (5) 

 Memory Window 

• Up to 4 Memory windows can be displayed in tabs 

• Memory is updated during runtime 

• Memory window tabs are shared with Watch windows 

 

 

 

 Register View 

• Register view is a tab of the Project window 

• Changes are highlighted in dark blue text 

background 

• Register tree knots can be expanded 
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KEIL µVision – Debug (6) 

 Variable Windows 

• Watch Windows 

 Up to 2 Watch windows are sharing their tabs with e.g. Memory and Local 

views 

 Updated during runtime 

 Any changes are highlighted in dark blue text backround color 

 Displayed values can be changed by user during break 

 

 

• Local View 

 The local view shares the tab with e.g. Memory and Watch windows 

 Any changes are highlighted in dark blue text backround color 

 Displayed values can be changed by user during break 
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KEIL µVision – Trace (ULINK ME) 

 Trace via ITM 

• Simple Trace views via Instrumentation Trace Macro is supported by 

µLINK ME 

 Records 

 Exceptions 

 Counters 
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KEIL µVision – Trace (ULINK Pro) (1) 

 Trace via ETM 

• Check settings in menu: 

Flash→Configure Flash Tools... Tab:Debug 

 

enables ETM pins 
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KEIL µVision – Trace (ULINK Pro) (2) 

 Instruction Trace 

• Real Time Trace recording 

• Output can be filtered by several ETM and ITM events 

• Trace buffer is held in PC memory and transfered to µVision on break 
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KEIL µVision – Simulator 

 Simulator 

• The Core Simulator can be selected by the menu: 

[Flash] → [Configure Flash Tools...] → [Debug] 

and then choosing [Use Simulator] 

• Look & feel is like using ULINK debugger 

• Controlable also with *.ini files 
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Finally 
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Cypress Support 

 Please check the following website, for any available updates 

www.cypress.com 

http://www.cypress.com/
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Recycling 

 Gültig für EU-Länder: 

• Gemäß der Europäischen WEEE-Richtlinie und deren Umsetzung in 

landesspezifische Gesetze nehmen wir dieses Gerät wieder zurück. 

• Zur Entsorgung schicken Sie das Gerät bitte an die folgende Adresse: 

 Valid for European Union Countries: 

• According to the European WEEE-Directive and its implementation into 

national laws we take this device back. 

• For disposal please send the device to the following address: 
 

Cypress Semiconductor 

198 Champion Court 

San Jose, CA 95134 USA 

Tel: +1-408-943-2600 

 

 

 This board is compliant with China RoHS  


